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Bases de la modélisation polygonale : le menu spécial
Ce menu est accessible en mode Edit lorsque vous appuyez sur la
touche [W]. Il offre alors plusieurs options qui peuvent interagir avec vos
maillages, certaines étant accessibles par ailleurs (dans les panneaux de
certains menus, ou dans les en-têtes de certaines vues), et ayant été
regroupées dans ce menu par souci de convivialité. Les principales
options sont décrites ci-dessous.
• Subdivide : toutes les arêtes sélectionnées sont subdivisées en leur

centre.

• Subdivide Multi : toutes les arêtes sélectionnées sont subdivisées un
certain nombre de fois ; une fenêtre apparaît alors pour demander à
l’utilisateur le nombre de coupes (Number of Cuts) souhaitées. Par
exemple, deux coupes partageront une arête en trois segments.

• Subdivide Multi Fractal : identique à Subdivide Multi, sauf qu’une
fenêtre supplémentaire apparaît pour demander le pourcentage de
perturbation fractale ; en effet, le maillage ainsi produit sera déplacé
aléatoirement, sommet par sommet, dans une direction ou l’autre, ce
qui est idéal pour la génération de terrains irréguliers.

Figure 4–51
À droite, le cube 
après une simple subdivision

Figure 4–52
À droite, le cube après 
une subdivision à 4 coupes

Figure 4–53
À droite, le cube après subdivision à 4 coupes 
et déplacement fractal des sommets
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• Subdivide Smooth : identique à Subdivide Multi, sauf qu’une fenêtre
supplémentaire apparaît pour demander le taux de lissage du maillage
obtenu ; le lissage du maillage obtenu aura pour effet d’atténuer ses
creux et reliefs.

• Merge : cette fonction fusionne en un seul sommet tous les sommets
sélectionnés ; une fenêtre apparaît pour demander à l’utilisateur si la
fusion doit avoir lieu au centre théorique de la sélection (At Center) ou
sur la position du curseur 3D (At Cursor).

• Remove Doubles : cette fonction recherche dans la sélection de som-
mets tous ceux qui sont à une distance inférieure ou égale à 0.001
unités de Blender l’un de l’autre (cette valeur peut être réglée, en
mode Edit, dans le panneau Mesh Tools, menu Editing, touche [F9],
grâce au bouton numérique Limit), et supprime les sommets répon-
dant à ce critère. Ce traitement est souvent nécessaire après une opé-
ration d’extrusion ou de duplication avortée involontairement par
l’utilisateur ; les sommets excédentaires se manifestent souvent, dans
la vue 3D (mode ombré, touche [Z]) ou au cours du rendu, par des
artefacts dans le lissage des surfaces.

• Hide et Reveal : ces deux options permettent respectivement de mas-
quer la sélection, ou au contraire de la rendre à nouveau visible ; cette
opération est souvent utile lorsque l’utilisateur travaille sur un
maillage complexe, et qu’il veut n’afficher que la zone qui l’intéresse.
À noter que certains outils, comme l’outil d’édition proportionnelle,
n’ont aucune influence sur les facettes masquées. Les combinaisons
de touches [H] et [Alt]+[H] activent ces deux fonctions en mode Edit,
que l’on retrouve également dans le panneau Mesh Tools 1 du
menu Editing, touche [F9].

• Select Swap : permet d’inverser la sélection du maillage en cours.

Figure 4–54
À droite, le cube après subdivision simple

et adoucissement des angles

Figure 4–55
Les trois sommets du côté au premier plan ont

été fusionnés en un seul sommet central.
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• Flip Normals : les normales d’un maillage pointent en principe toutes
vers l’extérieur ou vers l’intérieur de celui-ci. Dans certains cas
(radiosité, par exemple), vous souhaiterez pouvoir inverser la direc-
tion des normales ; ce bouton vous le permet.

• Smooth : cette fonction permet de lisser la sélection de votre
maillage ; ses creux et ses bosses vont s’atténuer, et le maillage sem-
blera légèrement diminuer de volume. Par exemple, si vous partez
d’un cube subdivisé plusieurs fois, en appliquant cette fonction à plu-
sieurs reprises, vous allez obtenir un objet aux bords très arrondis.

• Bevel : cette fonction permet d’ajouter un chanfrein aux arêtes sélec-
tionnées de votre maillage (un script Python, Bevel Center, permet de
spécifier un rayon de congé, à la place d’un simple chanfrein) ; de
façon interactive, en déplaçant la souris (bouton gauche ou
touche [Entrée] pour valider, bouton droit ou touche [Echap] pour
annuler), vous spécifiez la largeur du chanfrein. Avant de valider,
vous pouvez également utiliser le bouton central pour basculer du
mode normal (chanfrein appliqué aux arêtes sélectionnées) au mode
sommets (chanfrein appliqué aux sommets).

• Set Smooth et Set Solid : vos maillages sont constitués de facettes ; lors
du rendu, les facettes seront clairement apparentes. En sélectionnant
un groupes de facettes (ou la totalité d’entre elles) et en utilisant la
fonction Set Smooth, le rendu donnera l’illusion que la surface de
l’objet est parfaitement progressive, au lieu d’être constituée de
facettes. Au contraire, Set Solid préserve l’aspect à facettes de l’objet.

Figure 4–56
À droite, le cube après plusieurs 
applications de la fonction Smooth

Figure 4–57
Sur un simple cube (à gauche), la fonction 
Bevel appliquée aux arêtes (au centre) 
ou aux sommets (à droite)

Figure 4–58
La moitié supérieure du cylindre est en 
Set Smooth, l’autre moitié en Set Solid.
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Travailler avec les boucles
Les boucles sont soit une suite continue d’arêtes qui démarrent et termi-
nent sur le même sommet, soit une suite continue de facettes qui démar-
rent et terminent sur la même arête. Dans le premier cas, il s’agit d’une
boucle d’arêtes, dans le second, d’une boucle de facettes.

Outil de transformation de sélection de boucle en région

Lorsqu’une boucle d’arêtes, ou une succession d’arêtes, est sélectionnée, délimitant une
région finie, l’option Loop to Region du menu Edge Specials, combinaison de
touches [Ctrl]+[E] (en mode Edit) permet d’afficher la sélection de toutes les facettes com-
prises à l’intérieur de ces frontières virtuelles.

Figure 4–59

Vous pouvez créer des frontières complexes grâce aux sélections multiples (touche [Maj]) de
boucles ou d’arêtes. Si vous définissez une sous-région enclose dans une plus grande région, les
facettes de la sous-région seront soustraites aux facettes de la grande région lors de l’usage de
l’outil Loop to Region. Vous pouvez ainsi multiplier à loisir les frontières, créant autant de
régions et de sous-régions que souhaité, ainsi qu’en témoignent les illustrations suivantes.

Figure 4–60

À noter l’existence de l’outil Region to Loop, qui fait exactement l’inverse de l’outil Loop to
Region : il transforme en boucles des groupes de facettes sélectionnées, n’en retenant que les
arêtes constituant la frontière de la région.

3DS MAX   Transformation de sélection

Dans 3ds max, la sélection en cours dans l’un des
modes (sommet, arête, facette...) n’affecte pas la
sélection dans les autres modes de sélection.
Il est donc nécessaire de passer par le menu con-
textuel (bouton droit) puis de sélectionner con-
vert to face, convert to vertex ou convert to
edge.
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Sélection de boucles d’arêtes ou de facettes

Il est possible de sélectionner une boucle d’arêtes en utilisant la combi-
naison de touches [Alt]+bouton droit de la souris sur une arête particu-
lière. De même, la sélection d’une boucle de facettes s’effectue en
utilisant la combinaison de touches [Ctrl]+[Alt]+ bouton droit de la souris.

Comme avec toute sélection dans Blender, il est possible d’ajouter à la
sélection d’autres boucles (d’arêtes ou de facettes) en maintenant pressée
la touche [Maj].

Couper une boucle de facettes

Il s’agit d’une fonction très intéressante, qui permet d’ajouter une boucle
d’arêtes au sein d’une boucle de facettes, ce qui revient à séparer en deux
(ou plus) la boucle de facettes. L’insertion de nouvelles boucles est une
technique communément utilisée en phase de modélisation pour ajouter
des détails en un endroit précis, principalement lors de la modélisation
d’objets organiques.

Pour couper une boucle de facettes, vous passerez par l’une des deux
méthodes suivantes :
• touche [K] pour appeler le menu Loop/Cut ;
• combinaison de touches [Ctrl]+[R] pour lancer directement l’outil

Loop Cut.

Dans les deux cas, une boucle d’arêtes couleur magenta apparaît pour
indiquer la boucle de facettes qui sera coupée ; vous pouvez alors sélec-
tionner une boucle d’arêtes à un endroit ou l’autre de votre modèle, plus
exactement en positionnant le curseur de votre souris sur une arête à
séparer, en validant la boucle de facettes choisies avec le bouton gauche
de la souris ou la touche [Entrée] (vous pouvez annuler l’action grâce au
bouton droit ou la touche [Echap]).

Après validation, Blender se place en mode interactif, vous autorisant à
positionner précisément la boucle d’arêtes ; ainsi, vous n’êtes pas obligé
de séparer une boucle de facettes en son milieu, mais à l’endroit de votre
choix, le long d’une arête transversale (en vert) à la future boucle.

Figure 4–61
À gauche, sélection d’une boucle d’arêtes, 
et à droite, sélection d’une boucle de facettes

ASTUCE   Insérer de multiples boucles

À noter que vous pouvez utiliser la molette de
votre souris ou directement saisir au clavier le
nombre de boucles d’arêtes que vous souhaitez
insérer.

ASTUCE   Supprimer une boucle d’arêtes

Il vous est possible de supprimer une boucle
d’arêtes, à condition qu’elle soit elle-même enca-
drée par deux boucles d’arêtes. Pour cela, sélec-
tionnez la boucle d’arêtes à supprimer grâce à la
combinaison de touches [Alt]+bouton droit et
appuyez sur la touche [X] ou la touche [Suppr]
pour appeler le menu Erase : choisissez alors
Edge Loop dans la liste.
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Pendant cette phase interactive, vous pouvez positionner à la souris la
nouvelle boucle d’arêtes. En bas à gauche de la vue 3D, vous pouvez
visualiser la position de la future boucle par rapport à l’arête de
référence : 0 correspond au milieu de l’arête, -1 à une extrémité, et +1 à
l’autre. En maintenant la touche [Ctrl] pressée, l’arête se positionnera
selon un pas grossier ; pour un placement plus fin, pressez la
touche [Maj].

Opérations spéciales sur les arêtes

Outils couteau (Knife)

L’outil couteau est un autre moyen d’ajouter des détails à un modèle. Il
ne fonctionne toutefois que sur un ensemble de facettes sélectionnées.
En appuyant sur la touche [K], un menu flottant apparaît vous deman-
dant quel type de coupure réaliser. Le curseur de la souris se change alors
en un petit couteau.

Figure 4–62
La ligne magenta indique

la boucle d’arêtes à diviser.

Figure 4–63
La boucle jaune positionne la future boucle

par rapport à l’arête verte.

Figure 4–64
La barre d’en-tête renseigne l’utilisateur 

sur la position de la coupe.

Figure 4–65
Le menu Loop/Cut
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• Knife (Exact) : le couteau est utilisé pour insérer des sommets aux
endroits exacts où sa trajectoire coupe une arête sélectionnée ; seule la
première intersection est prise en compte.

• Knife (Midpoints) : le couteau est utilisé pour insérer des sommets au
milieu des arêtes traversées.

• Knife (Multicut) : le couteau est utilisé pour insérer le nombre de som-
mets déterminés au milieu des arêtes traversées (une boîte de dia-
logue flottante apparaît pour déterminer le nombre de coupures).

Bien sûr, l’outil couteau peut traverser un nombre indéfini d’arêtes dis-
tinctes, mais un seul comportement (Exact, Midpoint, Multicut) est retenu
pour chacune de ces arêtes.

Rotation d’arêtes

Vous pouvez faire tourner une arête sur elle-même, soit dans le sens des
aiguilles d’une montre (CW), soit dans le sens inverse (CCW), sans
modifier la géométrie générale de votre modèle. Normalement, si vous
faites tourner une arête, elle conserve sa longueur, et donc, modifie la
forme de votre modèle. Dans ce cas particulier, la forme extérieure du

Figure 4–66

ASTUCE   Couper à travers un sommet

Si vous appuyez sur la touche [Ctrl] pendant que
vous dessinez la ligne de coupure, le couteau
devient aimanté et son tracé passe automatique-
ment par la position exacte du sommet le plus
proche. Lorsque la touche n’est pas pressée,
l’outil Knife conserve son comportement habituel.

Figure 4–67
Respectivement, la trajectoire du couteau, 
puis les résultats en mode Exact, 
Midpoint et Multicut
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modèle ne change pas ; c’est la longueur de l’arête qui se modifie en
fonction de son angle de rotation.

Pour accéder à cette fonction, sélectionnez l’arête à faire tourner et uti-
lisez la combinaison de touches [Ctrl]+[E] pour afficher le menu spécial
des arêtes. Choisissez ensuite Rotate Edge CW ou Rotate Edge CCW. Vous
validerez la nouvelle position de l’arête grâce au bouton gauche de la
souris (ou à la touche [Entrée]).

Glissement d’arêtes

Dans le même ordre d’idée que la rotation d’arêtes, il va s’agir de faire
glisser la position de l’arête sans modifier la forme extérieure du modèle :
c’est la longueur des arêtes liées à celle en cours d’édition qui variera
pour préserver la forme extérieure du modèle.

Pour accéder à cette fonction, sélectionnez l’arête à faire glisser et utilisez
la combinaison de touches [Ctrl]+[E] pour afficher le menu spécial des
arêtes. Choisissez ensuite Edge Slide pour faire glisser l’arête sélectionnée
le long de l’arête verte de référence. Vous validerez la nouvelle position
de l’arête grâce au bouton gauche de la souris (ou à la touche [Entrée]).

Figure 4–68
Le menu Edge Specials

BON À SAVOIR   Les arêtes attenantes

Blender ajoute autant de sommets, d’arêtes et de
faces que nécessaire pour préserver la géométrie
existante, avant l’usage de la fonction Rotate
Edge. Par exemple, sur la figure 4–69, nous
voyons clairement, en comparant le cube d’origine
à gauche et le cube après une opération de rota-
tion CCW à droite, que l’arête a pivoté, mais que
les arêtes horizontales anciennement contiguës à
celle-ci n’ont pas bougé.

Figure 4–69
À gauche, le modèle original, au centre,

rotation de l’arête dans le sens CW , et enfin,
à droite, rotation de l’arête dans le sens CCW

Figure 4–70
À gauche, le modèle original, au centre,

avec l’arête en cours de glissement,
et à droite, l’arête après glissement
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Déchirer un maillage

Il est possible de déchirer un maillage très simplement. En mode Edit,
sélectionnez un sommet, et appuyez sur la touche [V]. Vous êtes désor-
mais dans un mode interactif, et le sommet sélectionné est déplacé à la
souris (validation de la position grâce au bouton gauche ou à la
touche [Entrée]), laissant un trou dans le maillage.

Vous pouvez également sélectionner un ou plusieurs sommets contigus à
la fois, et même des arêtes contiguës.

Les espaces ainsi créés peuvent servir d’ouverture (manches, bouches,
paupières) ou être par la suite remplis grâce à de nouvelles facettes pour
former des rides ou des plis.

Maillages multirésolution
Les maillages multirésolution permettent de stocker différents niveaux
de subdivision, tout en garantissant que chaque niveau soit éditable, et
que les modifications apportées à un niveau soient communiquées aussi
bien aux niveaux inférieurs que supérieurs de résolution. Quelques avan-
tages parmi les plus évidents :
• possibilité de travailler (mise en place d’armatures, mise au point

d’animations, etc.) sur un modèle de faible résolution dans la vue 3D
sans ralentissement excessif et d’effectuer des rendus avec des
maillages de haute (voire très haute) résolution avec tous les détails
qui y ont été intégrés ;

• correction aisée de la forme générale d’un maillage sur une version
basse résolution par action sur quelques sommets seulement, plutôt que
par modifications laborieuses (à coups d’outils de sélection et d’outils
d’édition proportionnelle) sur des quantités massives de sommets.

Une limitation importante à saisir est qu’il n’est pas possible d’ajouter à
la géométrie des formes. On peut seulement les éditer et les subdiviser.
Cela veut dire que, à un niveau de résolution donné, il est impossible
d’ajouter ou de supprimer des sommets, arêtes ou facettes.

Les maillages multirésolution sont particulièrement utiles lorsqu’ils sont
employés conjointement à l’outil de sculpture 3D, le Sculpt mode. Il est

Figure 4–71
Déchirure du maillage en un sommet précis
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possible d’activer la multirésolution d’un maillage grâce au bouton Add
Multires du panneau Multires du menu Editing [F9].

• Apply Multires : applique le niveau de résolution actuel au maillage, tout
en supprimant tous les autres niveaux, supérieurs comme inférieurs.

• Add Level : accroît d’un niveau le niveau de résolution du maillage. Ce
nouveau niveau devient le niveau courant de résolution. Il est possible
de choisir le type de subdivision conduisant à ce nouveau niveau :
Catmull-Clark ou Simple Subdiv., exactement comme avec le modifica-
teur Subsurf.

Dès qu’au moins un niveau de résolution a été ajouté, d’autres boutons
apparaissent pour permettre à l’utilisateur de gérer les différents niveaux
de résolution.
• Del Lower, Del Higher : supprime tous les niveaux de résolution infé-

rieurs (Del Lower) ou supérieurs (Del Higher) au niveau courant.
• Level : détermine le niveau de résolution courant, visible et éditable

dans la vue 3D.
• Edges : affiche les arêtes du maillage conformément au niveau de

résolution précisé, ce qui permet d’afficher la topologie du maillage
sans que la vue soit encombrée par un trop grand nombre d’arêtes
pour les hauts niveaux de subdivision.

Le deux dernières options sont relatives au rendu de l’objet multi-
résolution :
• Pin : impose le niveau d’effet des modificateurs à appliquer à l’objet

au moment du rendu ;
• Render : définit le niveau de subdivision à prendre en compte au

moment du rendu.

Enfin, vous noterez que la carte UV et les informations comme les seams
(coutures de dépliage) et les creases (dureté des arêtes) ne peuvent être
stockées qu’au premier niveau de subdivision. De plus, les Shape Keys
(formes clé d’animation) ne peuvent pas être utilisées avec un maillage
multirésolution.

Figure 4–72
Le panneau Multires, après activation

de la fonction, et après ajout
d’un premier niveau de subdivision
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Retopologie
La retopologie est une méthode permettant de construire un nouveau
maillage sur les bases de la surface d’autres objets qui peuvent être aussi
bien des maillages que des métaballes ou encore des surfaces NURBS.
L’emploi de la retopologie peut répondre à divers besoins :
• conversion manuelle d’un objet procédural (métaballes) ou mathéma-

tique (NURBS) en un maillage ;
• reconstruction d’un maillage mal modélisé en vue de permettre sa

bonne déformation lors des animations ou d’un simple nettoyage ;
• aide à la modélisation d’éléments devant s’ajuster finement aux

formes d’un autre objet (modélisation de vêtements ou de parures,
par exemple).

La retopologie est une technique qui peut nécessiter de solides bases de
modélisation pour en tirer un meilleur parti que la modélisation tradi-
tionnelle, en particulier lorsque l’objectif est de reproduire un objet exis-
tant tout en optimisant le maillage ou en le rendant propre à l’animation
à l’aide d’armatures, par exemple.

Lorsque vous entrez en mode Edit ([Tab]), l’onglet Mesh du menu Editing
[F9] présente un bouton Retopo. Si vous l’activez, une paire de boutons
supplémentaires apparaît.
• Retopo : active/désactive le mode de retopologie.
• Paint : active/désactive les outils de peinture de polygone, permettant

de dessiner des lignes dans la vue 3D.
• Retopo All : déplace les sommets sélectionnés sur la surface de l’objet

modèle.

Retopologie par modélisation
La méthode pour effectuer une retopologie est simple, mais atypique :
affichez votre modèle (ou la portion du modèle qui vous intéresse) et
ajoutez un nouvel objet Mesh (peu importe lequel ; par exemple, un plan :
Add>Mesh>Plane). Tout en restant en mode Edit, assurez-vous que tous

Figure 4–73
Les options Retopo du panneau Mesh

BON À SAVOIR   La retopologie 
et la complexité des objets modèles

La retopologie fonctionne sur la base du tampon
de profondeur de la vue 3D active ; l’objet modèle
aura beau être complexe, il n’affectera en rien la
vivacité des outils de retopologie.
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les sommets sont bien sélectionnés (touche [A], une à deux fois, si néces-
saire) puis, supprimez-les (touche [X]). Oui, vous avez bien lu, il faut les
supprimer mais rester en mode Edit : enclenchez le bouton Retopo du
panneau Mesh, puis ajoutez un premier sommet avec la combinaison de
touches [Ctrl]+bouton gauche de la souris, puis un autre, etc. Vous êtes
désormais dans un cadre de modélisation polygonale classique, à l’excep-
tion que tous les sommets ajoutés seront « déposés » à la surface de l’objet
modèle.

Tant que le bouton Retopo est actif, les opérations affectant les sommets
(déplacement, touche [G], rotation, touche [R] et redimensionnement,
touche [S]) les maintiendront sur la surface de l’objet modèle. L’ajout de
nouveaux sommets a lieu avec la combinaison de touches [Ctrl]+bouton
gauche, une arête étant automatiquement créée entre le nouveau sommet
et le dernier sommet sélectionné, et positionnée sur la surface de l’objet
modèle. Il en est de même si la technique d’extrusion (touche [E]) est
employée pour construire le nouveau maillage.

Retopologie par peinture des polygones
Le mode Paint n’est disponible que lorsque l’objet en cours de création
est de type Mesh (les objets de type Curve ou Surface ne peuvent donc en
bénéficier). Il permet de dessiner des traits à main levée, des segments de
droite ou des ellipses, les traits résultants étant bien sûr automatique-
ment positionnés à la surface du modèle ; un sommet est positionné à
chaque intersection de deux traits, et l’usage de la touche [Entrée] permet
de générer les triangles ou les quadrangles correspondant à ce qui a été
peint. Si le polygone formé par les traits se croisant comprend plus de 4
côtés, la facette n’est pas créée, Blender n’acceptant que des triangles ou
des quadrangles. L’utilisateur doit alors recourir aux outils traditionnels
de modélisation polygonale pour compléter les facettes manquantes.

Les outils de peinture disponibles sont relativement primitifs :
• Pen : permet de tracer des traits à main levée ; il est possible d’activer

l’option Hotspot, qui permet à l’outil Pen de détecter l’extrémité d’un
autre trait de type Pen, et de démarrer directement à partir de celui-ci.
Si une extrémité est détectée à proximité du pointeur de la souris, elle
est automatiquement encerclée ;

Figure 4–74
Les différents types de trait

du mode Paint de la fonction Retopo

ASTUCE   Retopologie avec des courbes ?

Le bouton Retopo est également disponible en
mode édition pour des objets de type Curves ou
Surfaces (Add>Curves>... ou Add>Sur-
faces>...). Il apparaît alors dans le
panneau Curve Tools1.

ASTUCE   L’option X-ray

Si vous avez du mal à visualiser le nouveau
maillage parce qu’il se confond avec le modèle, ou
parce que certaines facettes passent totalement
ou partiellement sous sa surface, vous trouverez
avantage à activer le bouton X-ray
(panneau Draw, Object buttons, menu Object,
touche [F7]).
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• Line : permet de tracer un segment de droite ; le paramètre LineDiv
permet de déterminer le nombre de subdivisions du segment, une
valeur importante lui permettant de se conformer plus facilement à
un modèle complexe ;

• Ellipse : permet de tracer une ellipse ; le paramètre EllDiv détermine le
nombre de segments constituant l’ellipse ; trois segments produisent
un triangle, quatre un carré, et ainsi de suite, un nombre élevé ten-
dant à produire une ellipse parfaitement continue.

Exemple simple d’usage de la fonction de retopologie
Il n’est pas nécessaire d’avoir à rebâtir un maillage entier pour trouver
des applications utiles au quotidien de la fonction Retopo. Un exemple
simple est la modélisation de vêtements ou de parures pour des person-
nages, comme le montre l’exercice suivant : lancez une nouvelle session
de Blender, ou réinitialisez la scène courante (combinaison de
touches [Alt]+[X]). Supprimez (touche [X]) le cube par défaut, rem-
placez-le par la tête de Suzanne (Add>Mesh>Monkey) et quittez le
mode Edit (touche [Tab]). Zoomez dans la vue et faites-la pivoter pour
avoir une bonne vision du front de Suzanne. Idéalement, ajoutez un
modificateur de type Subsurf (panneau Modifiers, Add Modifier>Subsurf)
et lissez l’ombrage des facettes (bouton Set Smooth du panneau Link and
Materials), le tout dans le menu Editing, touche [F9]. L’objectif va être
simple : ajouter un serre-tête à Suzanne.

Ajoutez maintenant un maillage quelconque (Add>Mesh>Plane) et tant
que tous les sommets sont sélectionnés, supprimez-les (touche [X]) pour
obtenir un objet vierge, mais toujours en mode Edit (ne touchez donc pas
à [Tab] !). Activez ensuite le bouton Retopo, puis le bouton Paint. Dans
l’en-tête de la vue 3D, sélectionnez l’outil de dessin à main levée, Pen.

ASTUCE  Bouclage des lignes

La touche [C] permet de déterminer si le trait cou-
rant (qu’il soit obtenu par les outils Pen, Line ou
Ellipse) boucle sur lui-même ou non. Par exemple,
tracez une forme non close avec l’outil Pen, et
appuyez sur la touche [C] pour la clore.

Figure 4–75
Notre objet modèle est en place, 
il ne reste plus qu’à esquisser un serre-tête.
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Dessinez un bandeau grâce à deux lignes vaguement horizontales (sui-
vant quand même la courbure de la tête) que vous quadrillez de lignes
verticales, relativement rapprochées.

Validez la création des polygones grâce à la touche [Entrée] et observez le
maillage qui a été créé par le mode Retopo : à chaque intersection de
ligne, un sommet à été positionné, et les facettes créées à partir de
chacun des sommets. Dans le menu Object, touche [F7], activez
l’option X-ray dans le panneau Draw pour mieux visualiser l’ébauche de
serre-tête, puis revenez dans le menu Editing, touche [F9]. Dans
l’onglet Modifiers, ajoutez un modificateur de type miroir (Add Modi-
fier>Mirror) qui, par défaut, devrait convenir à vos besoins si vous avez
suivi les instructions pas à pas (ajustez tout de même la valeur Merge
Limit à 0.1000 environ).

Malheureusement, le serre-tête ne couvre pas la tempe, nous allons donc le
prolonger un peu : en sélectionnant la dernière arête (ou les deux sommets

Figure 4–76
L’outil Pen permet de dessiner à main levée

la topologie du futur serre-tête en plaçant
un sommet à chaque intersection.

Figure 4–77
Le serre-tête commence à se dessiner, en
suivant la courbure du crâne de Suzanne.
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la constituant), en vue de côté opposée (combinaison de touches [Maj]+[3]
du pavé numérique), extrudez cette arête grâce à la touche [E], à deux ou
trois reprises, en choisissant l’option Only Edges (attention, le bouton X-ray
peut être trompeur et provoquer l’ajout des arêtes du mauvais côté de la
tête, d’où l’usage de la vue de côté opposée, combinaison de
touches [Maj]+[3], au lieu de la vue de côté classique, touche [3]).

Nous allons maintenant donner de l’épaisseur au serre-tête grâce à un
script d’aide à la modélisation : sélectionnez tous les sommets formant la
base du bandeau (touche [A]) et, dans l’en-tête de la vue 3D, choisissez
Mesh>Scripts>Solidify Selection ; vous pouvez accepter les paramètres par
défaut, ou jouer avec si vous le souhaitez.

Nous avons dans cet exercice réalisé quelque chose de grossier, certes,
mais très facilement. Les polygones peints ont automatiquement été
ajustés à la surface de l’objet en modèle ; de même pour les facettes qui
ont été ajoutées par extrusion. La même technique fondamentale peut
être appliquée pour habiller un personnage (pantalon, ceinture, bracelet,
montre, collier, etc.), peaufiner un décor (route goudronnée, etc.) ou tout
autre travail nécessitant de démarrer avec des polygones épousant les
formes d’un autre objet.

Figure 4–78
Les bases du serre-tête sont désormais 
en place, ajustées au plus près 
du crâne de Suzanne.

Figure 4–79
Et voilà, Suzanne est désormais 
parée d’un serre-tête rudimentaire.
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Opérations booléennes
Par le biais des opérations booléennes, il est possible de considérer les
maillages comme des volumes et, à ce titre, de réaliser des opérations
élémentaires entre ces volumes. Les opérations booléennes disponibles
sont les suivantes :
• union – les volumes sont ajoutés les uns aux autres ;
• intersection – seuls les volumes communs aux différents objets sont

conservés ;
• différence – l’un des volumes est soustrait au second.

Dans Blender, une opération booléenne ne peut être employée que sur
deux objets à la fois. Autant que possible, ils ne doivent pas avoir de faces
coplanaires, ce qui risquerait d’entraîner l’échec de l’opération. Sélec-
tionnez un objet (bouton droit de la souris), puis ajoutez un second objet à
la sélection (touche [Maj] pressée, bouton droit de la souris). Appuyez sur
la touche [W] pour appeler le menu des opérations booléennes.

Quelle que soit l’opération utilisée, le résultat sera présenté sous forme
d’un maillage totalement indépendant des maillages d’origine ; les objets
résultants et d’origine se superposeront donc, mais vous pouvez sélec-
tionner les objets d’origine et les expédier un à un sur un calque invisible
(touche [M], sélectionnez un calque inactif, puis appuyez sur la
touche [Entrée] ou cliquez sur le bouton OK).

Considérons une scène très simple, constituée d’une sphère noire et d’un
cube blanc.

• Union : avec cette opération, les deux maillages sont fondus en un
seul, en ne conservant que les facettes constituant l’enveloppe exté-
rieure. Les sommets, arêtes et faces en surplus à l’intérieur des deux
volumes sont supprimés.

Figure 4–80
Le menu des opérations booléennes

ASTUCE   En cas de faces coplanaires

Si vous cherchez à appliquer une opération boo-
léenne sur deux objets dont une ou plusieurs faces
sont coplanaires, l’opération se soldera par un
échec. Généralement, faire pivoter l’un des deux
objets d’un angle très faible pour rompre le carac-
tère coplanaire suffit pour que l’opération soit un
succès à la seconde tentative.

Figure 4–81
Les objets d’origine

de nos opérations booléennes
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• Difference : pour cette opération, l’ordre de sélection a une impor-
tance, car l’objet actif (le dernier sélectionné) sera soustrait au pre-
mier objet sélectionné. Vous noterez que la surface résultante
commune aux deux anciens objets hérite de la couleur de l’objet qui
se soustrait.

• Intersection : pour cette opération, seul le volume commun aux deux
objets est retenu comme résultat de l’opération booléenne.

Figure 4–82
Le résultat d’une opération Union

Figure 4–83
Sélection du cube, puis de la sphère : 
la sphère se soustrait au cube.

Figure 4–84
Sélection de la sphère, puis du cube : 
le cube se soustrait à la sphère.

Figure 4–85
Intersection de la sphère et du cube
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Si les opérations booléennes semblent être particulièrement utiles, elles
sont surtout le fruit de la facilité, en ce sens que l’algorithme de généra-
tion des facettes, formant les volumes calculés, doit être optimisé. À ce
jour, les maillages résultants des opérations booléennes sont tout sauf
propres. Souvent, un grand nombre de facettes inutiles peuvent même
être générées, nécessitant soit le nettoyage « manuel » du modèle, soit
l’usage du modificateur de décimation.

Sculpture en 3D
Le mode Sculpt est une méthode de modélisation très différente de ce
qui a été présenté jusqu’à présent. Plutôt que d’éditer les sommets, arêtes
et facettes individuels d’un maillage, l’utilisateur fait usage de pinceaux
et de brosses pour manipuler la surface de l’objet. Quelques informations
de base sur ce mode particulier :
• l’ajout ou la suppression de nouveaux sommets, arêtes ou facettes

n’est pas permise ;
• l’usage des brosses est particulièrement adapté au travail avec des

maillages très denses ;
• le mode Sculpt est surtout adapté au façonnage de formes organiques

et courbes, plutôt qu’à celui de surfaces plus mécaniques, planes,
régulières ou dotées d’arêtes vives.

Le mode Sculpt fonctionne particulièrement bien conjointement aux
maillages multirésolutions avec un niveau de subdivision élevé. La possi-
bilité de naviguer d’un niveau de résolution à l’autre permet de sculpter
rapidement et facilement la forme générale du maillage à de faibles
niveaux de résolution, et de donner d’incroyables détails à leur surface
aux niveaux de résolution les plus élevés.

Pour activer le mode Sculpt, il suffit de changer le mode dans l’en-tête de
la vue 3D de votre choix. Trois nouveaux onglets (Sculpt, Brush et Tex-
ture) font alors leur apparition aux côtés du panneau Multires, dans le
menu Editing, touche [F9].

REMARQUE  Normales des volumes lors des opérations booléennes

Il est très important, pour obtenir des résultats prévisibles et satisfaisants, que toutes les nor-
males des volumes impliqués dans des opérations booléennes pointent, de façon consistante,
de préférence vers l’extérieur. En mode Edit, dans le panneau Mesh Tools 1 du
menu Editing, touche [F9], se trouve un bouton Draw Faces ; en l’activant, chaque face de
votre objet se voit assigner un petit vecteur décrivant la normale, et pointant vers l’intérieur
ou vers l’extérieur. S’ils ne pointent pas toujours dans la même direction, vous pouvez forcer
Blender à les recalculer de façon homogène grâce à la combinaison de touches [Ctrl]+[N].
Enfin, dans le panneau Mesh Tools se trouve un bouton Flip Normals, qui vous permet
d’inverser les normales de l’extérieur vers l’intérieur, et réciproquement.

Figure 4–86 Le passage au mode 
de sculpture se fait en un clic de souris.
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Le panneau Sculpt est divisé en trois parties : Brush, pour déterminer le
type d’outil de sculpture à employer ; Shape, pour en déterminer les pro-
priétés et caractéristiques ; et enfin Symmetry pour en déterminer le
mode d’application sur la surface.

Dans la vue 3D, lorsque le mode Sculpt est activé, le curseur de la souris
change de forme et est entouré d’un cercle dont la dimension peut être
déterminée grâce au paramètre Size. Le principe est simple : en mainte-
nant enfoncé le bouton gauche de la souris, déplacez le curseur pour que
la surface balayée soit déformée par la brosse. Il faut que la brosse soit en
mouvement pour affecter la surface : maintenir le curseur immobile au-
dessus de la même position tout en maintenant le bouton gauche appuyé
n’affecte la surface que si l’option Airbrush est active.

Les outils de sculpture
Les outils sont au nombre de sept et permettent des effets variés ; il
suffit de déplacer la brosse en maintenant enfoncé le bouton gauche de la
souris et de déplacer le curseur : la géométrie change.
• Draw : dessine un relief aux pentes douces sur la surface. Parfait pour

ajouter des collines à un paysage, ou des bosses à une peau.

Figure 4–87
Le panneau Sculpt

Figure 4–88 La taille de la brosse est matérialisée.

ASTUCE   Masquer une partie de l’objet

Le mode sculpture est redoutable avec des
maillages très denses, comme ceux que l’on
obtient en multirésolution à des niveaux élevés. En
conséquence, vous pouvez observer un ralentisse-
ment de votre ordinateur lors de la manipulation
de tels objets (rotation du point de vue ou zoom
dans la vue 3D).
En mode Sculpt, utilisez la combinaison de
touches [Maj]+[Ctrl]+bouton gauche pour
masquer l’intégralité de l’objet à l’exception de la
portion encadrée par la souris ; alternativement, uti-
lisez la combinaison de touches [Maj]+[Ctrl]+
bouton droit pour ne masquer que la portion
encadrée par la souris. La combinaison de
touches [Alt]+[H] permet de restaurer la visibilité
de toutes les portions masquées.

BON À SAVOIR  
Quelques options du menu Sculpt

Lorsque vous êtes en mode Sculpt, l’en-tête de la
vue 3D présente un menu Sculpt. En particulier, il
est possible d’y spécifier si la taille de la brosse
doit être matérialisée (Display Brush) ou de ne
rafraîchir que les surfaces balayées par la brosse
plutôt que la totalité du modèle (Partial
Redraw) si vous avez des soucis de performance
(sur certaines cartes graphiques, l’activer peut
engendrer des ralentissements : à n’utiliser que si
vous en avez vraiment besoin). Le sous-
menu Input Devices vous permet de régler le
comportement de vos périphériques d’entrée. Plus
précisément, si vous possédez une tablette gra-
phique, les options Tablet Size Adjust et Tablet
Strength Adjust permettent de relier la sensibi-
lité à la pression du stylet à la taille (Size) et/ou la
force (Strength) de la brosse.
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• Smooth : adoucit la surface du maillage, atténuant les aspérités.
Permet d’éroder les angles vifs d’un paysage, ou de lisser des rides
trop marquées sur une peau.

• Pinch : aspire les sommets (ou les repousse) vers le centre de la brosse,
permettant de pincer la surface. Permet de resserrer les parois d’un
canyon, les rides d’un visage ou les lèvres d’une personne.

• Inflate : repousse les sommets dans la direction de la normale à la sur-
face. Permet de creuser des cratères, ou de provoquer des éruptions de
verrues sur une peau.

• Grab : sélectionne un groupe de sommets et les déplace en même
temps que la brosse. Permet de sculpter directement la forme géné-
rale d’un relief ou d’un visage.

• Layer : permet de sculpter un plateau dont la hauteur est limitée. Pra-
tique pour délimiter une route ou un plateau.

• Flatten : permet d’aplatir les sommets sous la brosse jusqu’à obtenir
une surface plane.

La forme de la brosse peut évidemment être paramétrée. Toutes les
brosses ne possèdent pas toutes les mêmes réglages. Certaines en ont
moins que d’autres.
• Add, Sub : détermine si la brosse attire la matière, ou la repousse, per-

mettant de façonner des aspérités ou des cavités.
• Airbrush : actionne la modification continue du terrain lorsque le

bouton gauche de la souris est maintenu enfoncé, que le curseur de la
souris soit déplacé ou non.

• Size : définit la taille de la brosse par rapport à la vue 3D. En consé-
quence, si vous zoomez en avant ou en arrière de la vue 3D, la taille
relative de la brosse semble augmenter ou diminuer proportionnelle-
ment, par rapport à la surface sculptée.

• Strength : détermine la force de répulsion ou d’attraction de la brosse
sur la surface balayée.

Enfin, les boutons X, Y et Z de la section Symmetry permettent d’appli-
quer les coups de brosse symétriquement aux axes sélectionnés, ce qui
peut être très utile lorsque vous sculptez des modèles symétriques,
comme un visage ou une créature. Pour les détails, qui ne devront proba-
blement pas être repris de façon symétrique, ainsi que pour des sculp-
tures volontairement asymétriques, il suffit à l’utilisateur de décocher les
boutons activés pour revenir à un comportement normal des outils.

Personnaliser les brosses
Il est possible de personnaliser les brosses, afin qu’elles prennent des
formes spécifiques et permettent de sculpter de façon très pointue cer-
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taines surfaces. Blender permet de travailler à deux niveaux : l’aire d’effet
de la brosse et son rendu.

Paramétrer l’aire d’effet

Il est possible de contrôler l’effet de la brosse grâce à une courbe qui
permet de définir interactivement son influence sur la surface et
d’obtenir ainsi des formes plus ou moins originales. Les points existants
se déplacent directement avec le bouton gauche de la souris (cliquer-
glisser), et il est possible de créer des points supplémentaires (bouton
gauche sur la courbe) ou d’en supprimer (petite icône de suppression en
forme de X, juste au-dessus de l’éditeur de courbe).

• Curve : définit la transition entre la zone affectée et la surface non
affectée. Par défaut, l’option Curve est active et la transition déter-
minée par la courbe de l’onglet Brush ; désactivée, la transition est de
type Spherefalloff mais cela n’est pas paramétrable différemment. Le
bouton Reset permet bien évidemment de rétablir la courbe de transi-
tion par défaut.

• Space : définit un espacement minimal (en pixels, le résultat étant
alors variable en fonction de la taille d’affichage ou du zoom de la vue
3D) entre deux zones affectées par la brosse lors de la même opéra-
tion (bouton gauche et déplacement, jusqu’à ce que le bouton soit
relâché). Cela permet de répéter des motifs à intervalles réguliers
lorsque cela est nécessaire.

Figure 4–89
Exemple de transition douce de l’aire d’effet sur la brosse 
par défaut, et une brosse spéciale à laquelle a été attribuée une 
texture procédurale Clouds, pour un rendu de la surface très 
différent !

Figure 4–90
L’éditeur de courbes qui pilote 
l’aire d’effet d’une brosse
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• View : définit la vue vers laquelle la brosse est tirée lorsque le bouton
gauche de la souris est pressé.

• Anchored : lorsque cette option est active, le centre de la brosse ne suit
pas les mouvements de la souris, mais reste ancré sur sa position ini-
tiale, le mouvement de la souris définissant alors l’amplitude de la
déformation appliquée par la brosse.

Le rendu de la brosse

La brosse par défaut affecte uniformément la surface dans l’aire d’effet,
mais en associant une texture à une brosse (onglet Texture), vous person-
nalisez celle-ci et lui permettez de sculpter de façon irrégulière l’objet,
reproduisant les motifs de la texture sur sa surface. Les brosses acceptent
divers types de texture ; elles peuvent être procédurales, ou être des
images bitmap (voir chapitre 5).

Pour créer une nouvelle brosse personnalisée, cliquez sur un canal dispo-
nible en-dessous de la brosse nommée Default. Appuyez sur le bouton Add
New qui fait son apparition, avec de nouvelles options, en prenant soin de
la renommer de façon pertinente (champ TE:) afin de vous y retrouver si
vous créez plusieurs brosses personnalisées. Appuyez sur la touche [F6]
pour afficher les Texture buttons et, dans le panneau Preview, choisissez
Brush. Un onglet Texture fait son apparition, avec la texture créée dans
l’onglet Brush. Utilisez le menu déroulant Texture Type et choisissez Image
si vous souhaitez utiliser une image bitmap pour personnaliser la brosse,
ou l’une des nombreuses textures procédurales proposées.

Une fois une nouvelle texture ajoutée, l’onglet présente de nouvelles
options qui permettent de régler plus finement le comportement de cette
brosse personnalisée.

Figure 4–91
Les mêmes brosses que précédemment,

mais avec une transition beaucoup
 plus abrupte de la brosse !

Figure 4–92
Les options liées à l’usage de textures pour la

personnalisation de brosses
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• Drag : la texture suit la brosse, comme si elle était tirée par celle-ci.
Utilisez des points alignés en guise de texture, et vous creuserez la
matière comme si l’outil était un peigne ou un râteau.

• Tile : les coordonnées de la texture sont positionnées par rapport à la
vue 3D et non plus par rapport à la brosse. Cette option vous permet
de carreler la surface de l’objet sculpté avec la texture utilisée (un peu
comme l’option Repeat du panneau Map Image des Texture buttons
lorsqu’une texture de type Image est employée). À utiliser en particu-
lier avec des textures (bitmap ou procédurales) qui sont jointives.

• 3D : les textures procédurales peuvent être définies en 3D. Cette
option permet d’en tirer parti et d’avoir un positionnement de la tex-
ture par rapport aux sommets de l’objet sculpté plutôt que par rapport
aux coordonnées de la brosse.

• Angle : détermine l’angle optionnel de rotation de la texture dans son
plan propre.

• Rake : lorsque cette option est activée, la brosse se comporte comme
un rateau ou un peigne dans le sable ; cela veut dire que les sillons
tracés changent d’orientation pour suivre le mouvement du curseur
de la souris. Associée à une texture de type Wood (option Bands),
cette fonction est très utile pour sculpter des poils ou de la fourrure !

Modéliser un paysage grâce au mode Sculpt
Il s’agit en fait d’un excellent exercice permettant d’appréhender très
rapidement le mode Sculpt, procurant toutes les bases indispensables à la
sculpture de projets plus conséquents, comme un visage ou une créature.

Ouvrez une nouvelle session de Blender, ou réinitialisez la scène courante
(combinaison de touches [Ctrl]+[X]). Supprimez le cube par défaut
(touche [X]), ajoutez un objet de type Grid (Add>Mesh>Grid) et acceptez les
résolutions X et Y proposées (res: 32). Quittez le mode Edit (touche [Tab]),
appuyez sur la touche [S] et, en maintenant la touche [Ctrl] enfoncée, redi-
mensionnez l’objet Grid jusqu’à ce qu’il atteigne six fois sa taille précédente.
Faites pivoter la vue 3D pour voir le plan en légère perspective.

Nous allons commencer à façonner les caractéristiques générales de
notre paysage. Activez le mode Sculpt et affichez l’onglet Sculpt. Choi-
sissez l’outil Draw (Add, Size 50, Strength 25) et ajoutez quelques reliefs
vallonnés à votre paysage. Grâce à l’outil Inflate (Sub, Size 20,
Strength 85), dessinez un lit de rivière ; l’outil Pinch (Add, Size 50,
Strength 25) vous permettra d’en resserrer les bords. Grâce à l’outil Grab
(Size 50), accentuez un peu le relief d’un côté de la rivière, par grosses
touches, puis rendez-le un petit peu plus accidenté (Size 20) un peu par-
tout, par petites touches.
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La topologie générale ayant été définie, nous allons nous intéresser aux
détails. Dans le panneau Multires, activez la multirésolution grâce au
bouton Add Multires, puis appuyez sur Add Level (vous êtes désormais au
niveau 2). Dans le panneau Texture, choisissez un canal vide, ajoutez une
nouvelle texture (Add New) de type Clouds (touche [F6], bouton Brush,
Texture type : Clouds) puis revenez dans le menu Editing (touche [F9]).
S’agissant d’une police procédurale, activez l’option 3D. Sélectionnez
l’outil Draw (Add, Airbrush, Size 100, Strength 5) et balayez légèrement
toute la surface de la carte, en évitant le lit de rivière, pour rendre le ter-
rain un peu plus accidenté encore. Dans le panneau Multires, cliquez sur
Add Level (vous êtes désormais au niveau 3) et répétez l’opération précé-
dente avec le même outil Draw. Ajoutez un nouveau niveau de résolution
(Add Level, niveau 4) et toujours avec l’outil Draw (Add, Airbrush, Size 50,
Strength 5), ajoutez ici ou là un peu plus de détails, plus localisés. La sur-
face devrait désormais ressembler à une peau d’orange. Ajoutez mainte-
nant une nouvelle brosse (touche [F6], bouton Brush, Texture type :
DistortedNoise) et ajoutez un peu partout des détails, toujours avec
l’outil Draw; éventuellement, ajoutez une dernière brosse (touche [F6],
bouton Brush, Texture type : Noise) pour disposer de nombreux petits rocs
et cailloux.

Figure 4–93
Les principales caractéristiques

sont sculptées à de faibles
niveaux de subdivision.
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Dans le panneau Texture, sélectionnez à nouveau la brosse Clouds et dans
le panneau Sculpt, sélectionnez Grab (Size 75) ; par petites touches,
rehaussez encore le niveau de relief. Le terrain est désormais très chao-
tique, mais il ne vous reste qu’à renforcer l’effet d’érosion grâce à
l’outil Inflate (Sub, Airbrush, Size 25, Strength 5) en déplaçant la brosse
entre les reliefs proéminents, et/ou en resserrant les lèvres de ces mêmes
ravines grâce à l’outil Pinch (Add, Size 10, Strength 25).

Courbes et objets textes
De même que les méta-éléments, les courbes et les surfaces sont des
outils de modélisation hautement mathématiques. Ils ont l’avantage de
pouvoir décrire des surfaces courbes, éventuellement complexes, avec
peu de points de contrôle (ou « sommets », pour respecter l’analogie avec
la modélisation polygonale).

Blender propose de travailler avec deux types de courbes distinctes : les
courbes de Bézier et les NURBS (Non Uniform Rational B-Splines). Cha-
cune fonctionne sur la base de points de contrôle permettant de façonner
la courbe, mais chacune se conforme à ses propres lois. Les NURBS
(courbes ou surfaces) ne seront toutefois pas abordées dans cet ouvrage.

Figure 4–94
Les détails du terrain sont 
progressivement introduits.

Figure 4–95
La texture même du terrain 
est suggérée aux niveaux de 
subdivision les plus élevés.

BON À SAVOIR   L’avenir des NURBS

Si elles sont parfaitement fonctionnelles à ce jour
dans Blender, tant les surfaces que les courbes
NURBS devraient faire l’objet d’une refonte totale
dans le cadre d’une prochaine version de Blender.
Elles ne sont pas abordées dans cet ouvrage en
raison du retard pris par rapport à la modélisation
polygonale, au profit des courbes de Bézier, étu-
diées un peu plus en profondeur.
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